# Table of Contents

Navigating the User’s Guide ............................................. 2

**Setting Up Your Printer ........................................... 3**
  - Connecting your printer with a parallel printer cable ........... 3
  - Connecting your printer with a USB Cable ......................... 12
  - More information about your printer software ................. 22

**Printing Basics ......................................................... 24**
  - How to choose paper .................................................. 24
  - Finding the HP print settings box .................................. 26
  - How to print on standard paper sizes .............................. 28
  - How to print on different paper sizes .............................. 30
  - How to print on both sides of the paper ............................ 31
  - How to create a mirror image of your document ................. 32
  - About color .............................................................. 34
  - About pictures .......................................................... 35

**Beyond the Basics ..................................................... 37**
  - Printing Photographs .................................................. 38
  - Printing Envelopes .................................................... 40
  - Printing Cards ........................................................... 42
  - Printing Labels .......................................................... 44
  - Printing Transparencies .............................................. 45
  - Printing Iron-On Transfers .......................................... 47

**Getting Help ............................................................ 48**
  - HP Customer Care .................................................... 48

**Appendices ............................................................ 54**
  - The HP DeskJet Toolbox ............................................. 54
  - Print cartridges ......................................................... 55
  - Maintaining your printer .............................................. 63
  - Increasing printer performance .................................... 64
  - Minimum printing margins .......................................... 65
  - System Requirements .................................................. 65
  - Supplies and accessories ............................................. 66
  - Ordering Information .................................................. 68
  - Language Codes for DOS ............................................. 69
  - Environmental Attributes of the DeskJet Printer ............... 70
Navigating the User’s Guide

Use the navigation controls at the bottom of each page to move through the guide:

- Go to the Table of Contents
- Go to previous page
- Go to next page
- Print this page

Acrobat® Reader provides a number of ways to page through a document. You may use the navigation buttons in the toolbar.

You may also press the arrow keys or choose an action from the View menu. Refer to the Acrobat Reader Online Guide for more information.
Your HP DeskJet printer is designed for connection to your computer using either of the following cables:

**Parallel printer cable** — You can use this method when your computer is running either Windows 3.1x, 95, 98, NT 4.0, or Windows 2000 Professional. See “Connecting your printer with a parallel printer cable” on page 3 for instructions.

**Universal Serial Bus (USB) cable** — This method is only supported if you are running Windows 98 or Windows 2000 Professional on your computer. See “Connecting your printer with a USB Cable” on page 12 for instructions.

**The printer cable is not supplied with the printer.** You must purchase the printer cable separately. See page 66 for ordering information.

---

**Connecting your printer with a parallel printer cable**

*Note: If you are using a USB cable for communications between your printer and your computer, see page 12.*
Step 1: Unpack your printer
1. Remove the packing material and the packing tape from the outside of the printer.
2. Open the top cover and remove the plastic packing material from the inside of the printer.
3. Close the top cover.

Step 2: Connect parallel cable
You’ll need to buy a printer cable that supports bi-directional communication (IEEE 1284-compliant), such as HP part number C2950A.
1. Make sure both the printer and the computer are turned off.
2. Plug the end of the cable that does not have screws attached into the printer. Snap both clips into the notches.
3 Plug the other end into the computer and tighten the screws.

4 Plug the other end of the power cord into an electrical outlet.

Step 3: Plug in the power cord
1 Leave the computer and the printer turned off.
2 Plug the power adapter cord firmly into the connector on the back of the printer.
3 Plug the appropriate end of the power cord into the power adapter.

Note: Always use the Power button on the front of the printer to turn the printer on and off. Using a power strip, surge protector or a wall outlet switch to turn the printer on and off may cause premature failure.
Step 4: Load paper in your printer

1. Slide out the paper adjusters as far as possible.

2. Remove a stack of paper from its packaging. (Make sure all the paper in the stack is the same size and type.) Tap the stack on a flat surface to even it up.

3. Load the paper into the IN tray, **printable side down.** Push the paper toward the back of the paper tray until it stops.
4 Slide both paper adjusters to fit snugly against the paper’s edges.

**Step 5: Insert print cartridges**

1. Press the Power button to turn on the printer.
   The Power light comes on.
2. Open the top cover.
   The print cartridge cradle moves to an accessible position, and the Resume light flashes.
3. Remove the print cartridges from their individual packages.
4 Carefully remove the protective vinyl tape from the tri-color and black print cartridges.

**Note:** Be sure not to touch the ink nozzles or the copper electrical contacts. Also, do NOT remove the copper strip; these are electrical contacts required for proper operation of the print cartridges.

Insert the black print cartridge in the right cradle, and insert the tri-color print cartridge in the left cradle. You must insert both print cartridges for the printer to operate.

5 Close the top cover.

The Resume light continues to blink for awhile and then goes off. (You’ll hear the cartridge cradle return to its home position on the right side of the printer.)
Step 6: Install printer software

Before you can use your new HP DeskJet printer, you must install the printer software on the computer from which you will print. Your printer software is located on the CD included with your printer.

From time to time, Hewlett-Packard provides updated printer software. Go to “Printer Software” on page 50 for information on obtaining updated printer software.

Before You Begin

1. Make sure the computer is fully set up and operational.
2. Make sure that the printer is properly set up and ready to print using the instructions provided earlier.
3. Make sure that the printer is connected to the computer with a parallel printer cable and that no peripheral devices (such as scanners, backup units, and switch boxes) are installed between the printer and the computer.
4. Make sure both the printer and the computer are turned on.
5. Close any software programs that are open and running on the computer, except the HP DeskJet installer, Windows Explorer, or Program Manager. See page 22 for instructions on how to close software programs.

Note: If the Resume light continues to blink or if the cradle doesn’t move to the right side of the printer, take out both cartridges and reinsert them.

When a print cartridge starts to run out of ink, replace it. If you do not have a replacement, leave the empty print cartridge in the cradle of the printer. The printer will not print with only one print cartridge installed.

We recommend you keep spare print cartridges on hand. When buying print cartridges, check the part numbers referenced below carefully to make sure you are buying the right print cartridges for your printer. These print cartridges have been specifically designed to work with your printer to produce results that are always clear, always sharp.

- Black HP No. [15] (equivalent to C6614 Series)
- Tri-Color HP No. [49] (equivalent to 51649 Series)
- HP Photo Cartridge C1816
Installing printer software from the CD
Windows 95, 98, and NT 4.0:
1. Turn on your computer and wait for Windows to start.
2. Insert the HP printer software CD into your CD-ROM drive.

Note: If the New Hardware Found box appears during the installation procedure, click the “X” in the upper-right corner of the box, or click Cancel.


4. Click Browse.

5. Browse to the CD icon.

6. Click on Setup.

7. Click Open.
8 Setup file appears in the Run dialog box. Click OK.

9 Follow on-screen instructions to install your printer software.

Windows 3.1x:
1 In Program Manager, select File ➔ Run.
2 Type the identifier of your computer’s CD-ROM drive, then type setup.exe. For example, D:\setup.exe, then click OK.
3 Follow on-screen instructions to install your printer software.

Note: If you don’t know which drive letter is for your CD-ROM player, open Windows Explorer or File Manager and look for the letter next to the CD-ROM icon.

Windows 2000 Professional
If you are a Windows 2000 Professional user, visit HP’s web site at http://www.hp.com/cposupport/eschome.html for more information.

Note: If you need the printer software on floppy disks:
- Contact your local HP Customer Care Center, listed on page 51.
OR
- If you have access to a computer with a CD-ROM drive, insert the printer software CD in this computer’s CD-ROM drive and begin the software installation. When the opening screen appears, select Make diskettes of your printer software.
If you have problems installing

- Make sure your printer is on and all connections are firm.
- Exit your software programs. Then turn off the computer and the printer. Turn on the printer, then turn on the computer.
- Close any virus protection programs that are running on your computer. Either right-click the virus protection program’s icon on the taskbar and select Disable, or click the “x” in the upper-right corner of the virus protection program’s open window.
- Uninstall the printer software using the instructions on page 23 then repeat the installation procedure.
- If you’re still having problems with the installation, call an authorized HP dealer or HP Customer Care representative. For the phone number of the support center nearest you, see HP Customer Care by Phone on page 51.

Connecting your printer with a USB Cable

What is USB?

Universal Serial Bus (USB) makes it easy to connect devices to your computer without having to open your PC. USB uses a standard port and plug combination for connecting devices like printers, modems, scanners, and digital cameras. It also offers the benefit of being able to easily add, remove, and move devices.

USB is an option to customers who want to print from Windows 98 or Windows 2000 Professional across the USB cable. If your computer’s USB port is enabled and properly set up, you can connect your HP DeskJet printer to it or to a chain of USB devices via a USB cable.

Note: The USB cable set up requires Windows 98 or Windows 2000 Professional. If you are using a parallel cable for communications between your printer and your computer, see page 3.
USB Step 1: Unpack your printer

1. Remove the packing material and the packing tape from the outside of the printer.
2. Open the top cover and remove the plastic packing material from the inside of the printer.
3. Close the top cover.

USB Step 2: Plug in the power cord

1. Leave the computer and the printer turned off.
2. Plug the power adapter cord firmly into the connector on the back of the printer.
3. Plug the appropriate end of the power cord into the power adapter.
4. Plug the other end of the power cord into an electrical outlet.

Note: Always use the Power button on the front of the printer to turn the printer on and off. Using a power strip, surge protector or a wall outlet switch to turn the printer on and off may cause premature failure.
USB Step 3: Load paper in your printer

1. Slide out the paper adjusters as far as possible.

2. Remove a stack of paper from its packaging. (Make sure all the paper in the stack is the same size and type.) Tap the stack on a flat surface to even it up.

3. Load the paper into the IN tray, *printable side down*. Push the paper toward the back of the paper tray until it stops.
4 Slide both paper adjusters to fit snugly against the paper’s edges.

USB Step 4: Insert print cartridges

1 Press the Power button to turn on the printer. The Power light comes on.

2 Open the top cover. The print cartridge cradle moves to an accessible position, and the Resume light flashes.

3 Remove the print cartridges from their individual packages.
4 Carefully remove the protective vinyl tape from the tri-color and black print cartridges.

**Note:** Be sure not to touch the ink nozzles or the copper electrical contacts. Also, do NOT remove the copper strip; these are electrical contacts required for proper operation of the print cartridges.

Insert the black print cartridge in the right cradle, and insert the tri-color print cartridge in the left cradle. You must insert both print cartridges for the printer to operate.

5 Close the top cover.

The Resume light continues to blink for awhile and then goes off. (You'll hear the cartridge cradle return to its home position on the right side of the printer.)
**USB Step 5: Insert printer software CD in the computer**

1. Turn on the computer and wait for Windows 98 to start.
2. Insert the HP printer software CD into your CD-ROM drive.

**Note:** Your printer software will not start until after you have connected the USB cable.

---

**Note:** If the Resume light continues to blink or if the cradle doesn’t move to the right side of the printer, take out both cartridges and reinsert them.

When a print cartridge starts to run out of ink, replace it. If you do not have a replacement, leave the empty print cartridge in the cradle of the printer. The printer will not print with only one print cartridge installed.

We recommend you keep spare print cartridges on hand. When buying print cartridges, check the part numbers referenced below carefully to make sure you are buying the right print cartridges for your printer. These print cartridges have been specifically designed to work with your printer to produce results that are always clear, always sharp.

- **Black** HP No. [15] (equivalent to C6614 Series)
- **Tri-Color** HP No. [49] (equivalent to 51649 Series)
- **HP Photo Cartridge** C1816
USB Step 6: Connect USB cable

1. Plug one end of the USB cable into the USB port on the printer.
2. Plug the other end into any USB port on the computer.

USB Step 7: Install USB and printer software

Windows 98

1. After a few seconds, the Add New Hardware Wizard screen appears.

Note: You can also refer to steps 8a through 8h on the USB Cable Setup Quick Start Poster

Note: If the Add New Hardware Wizard screen does not appear, your computer may not be USB-enabled. You can still enjoy the full capabilities of your HP DeskJet 640C Series printer by connecting the printer to the computer with a parallel cable. Go to “Connecting your printer with a parallel printer cable” on page 3 for setup instructions.

2. Click Next.
3 Click Next in this screen, too.

4 Select Specify a location and then click the Browse button. Do NOT click Next.

5 Double-click the CD icon. Click on the win98usb folder, then click OK.

6 Click Next.

The Add New Hardware Wizard searches for the win98usb driver. If Windows is unable to locate a driver, click Back to return to Step 4.
7 When the driver file is located, click Next.

When the driver file is located, click Next. The driver file is installed on your computer.

8 When you are notified that installation of the USB software is completed, click Finish.

Soon the opening screen for installing the HP DeskJet printer software appears. Click Next, and follow the on-screen instructions.

If something goes wrong with the USB software installation, go to “Problems with your USB installation?” on page 21.

9 Soon the opening screen for installing the HP DeskJet printer software appears. Click Next, and follow the on-screen instructions.

If something goes wrong with the printer software installation, go to “If you have problems installing” on page 12.

Windows 2000 Professional

If you are a Windows 2000 Professional user, visit HP’s web site at http://www.hp.com/cposupport/eschome.html for more information.
Problems with your USB installation?

How can I determine if my computer's USB port is enabled?

First, follow the installation instructions beginning on page 12. If you don't see the Add New Hardware Wizard screen after connecting your printer to your computer, perform these steps:

1. In Windows 98, select Start ➔ Settings ➔ Control Panel.
2. Double-click the System icon.
3. Click the Device Manager tab.
4. Click the plus (+) icon before the Universal Serial Bus Controller item.

If you see a USB host controller and a USB root hub listed, USB is probably enabled. If your printer is connected through another USB device or hub, connect your printer directly to the USB port on the computer. Also, make sure the cable connections are firm. (USB hubs are hardware devices into which you can plug multiple USB cables.)

If you do not see these devices listed, refer to your computer's documentation or contact the manufacturer for more information on enabling and setting up USB. Remember, you can always use a parallel cable to connect your printer's parallel port to your computer.

I accidentally cancelled the USB installation the first time I connected my HP DeskJet printer to my computer. How do I get it to appear again?

To redisplay the USB installation screens:

1. Disconnect the USB cable from your printer.
2. Insert the printer software CD (or Disk 1 if you have diskettes) into your computer.
3. Click Start ➔ Run.
4. Browse to your disk drive and select Setup, then click Open.
5. The setup.exe file will appear in the dialog box. Click OK.
7. Connect the USB cable to your printer again. The USB installation screen should appear again.
8. Continue with the first step of "USB Step 7: Install USB and printer software" on page 18.
When I install the USB software, I get an “Unknown device is found” message.
Disconnect the USB cable, remove the printer software, and turn off the computer and printer. Unplug the electrical power to the printer, then reconnect your printer and restart the USB software installation.

After I installed my printer, why isn’t my HP DeskJet printer assigned to an LPT printer port in the Print dialog box of my software application?
USB uses a different naming convention for USB devices. After the printer has been installed, you see USB/DeskJet 640C/ (serial number of your printer).

How can I increase printing speed?
When operated on a USB chain, your printer may become slower if other USB devices or software applications are being used while you’re printing. For optimal print performance, avoid using other devices in the USB chain while printing.

More information about your printer software

Closing Software Programs
Before installing the printer software on a computer, close any virus protection programs or other software programs that are open and running on the computer, except the HP DeskJet installer, Windows Explorer, or Program Manager.

For Windows 95, 98, and NT 4.0:
- Right-click on the software program’s name or icon on the taskbar. Select Close. Repeat these steps for each open software program except Windows Explorer.

For Windows 3.1x:
1 While holding down the Alt key, press the Tab key to locate an open software program.
2 When you locate an open software program, release both keys.
3 Select File ➔ Exit.
4 Repeat these steps for each open software program, except Program Manager.
Uninstalling the printer software

If you need to uninstall the printer driver for your HP DeskJet printer for any reason, perform one of the steps listed below for your operating system. If something unexpected happened during installation, the safest method is to run the uninstall utility directly from the CD or disks, rather than from the uninstall program that was placed on your hard drive.

For Windows 95, 98, and NT 4.0:
Perform one of the following:

- Insert the printer software disk (either Disk 1 or your CD) into your computer and run Setup.exe. Select the option to Remove HP DeskJet 640C Series Software.

OR

- From the taskbar, select Start → Programs → HP DeskJet 640C Series → HP DeskJet 640C Series Uninstall.

OR

- From the taskbar, select Start → Settings → Control Panel. Then click Add/Remove Programs and select HP DeskJet 640C Series (Remove only).

For Windows 3.1x:
Perform one of the following:

- Insert the printer software disk (either Disk 1 or your CD) into your computer and run Setup.exe. Select the option to Remove HP DeskJet 640C Series Software.

OR

- In the Program Manager, locate your HP DeskJet Series group. Double-click the Uninstall icon to uninstall your printer software.

Printing from DOS

If you are using DOS, information can be found in a text document (dosread.txt). This document is on the printer software CD in the \{language code}\djcp\ directory. For example, “enu” is the language code for English, so dosread.txt is located in the \enu\djcp directory. For a list of language codes, see page 69. If you have diskettes, the file is located in the root directory.
How to choose paper

Most plain photocopy paper, postcards, index cards, transparencies, envelopes and labels work fine in your printer, particularly paper that is marked for use in inkjet printers. To get the best results, use one of the Hewlett-Packard papers, which were developed especially for HP inks and your printer.

What to consider:

- **Size.** You can use any size paper that fits easily within the paper adjusters of the printer.

  - width = 5 to 8.5 inches (127 to 215 mm)
  - length = 5.83 to 14 inches (148 to 356 mm)

- **Weight.** You can choose from a wide range of paper weights. Use 20-24 lb or 75-90 g/m² plain paper for multipurpose, everyday use.

- **Brightness.** Some papers are whiter than others and produce sharper, more vibrant colors. Use HP Premium Photo Paper, Glossy or HP Premium Plus Photo Paper, Glossy or Matte for printing documents with photographs. Use HP Bright White Inkjet Paper or HP Premium Inkjet Paper for documents with any other pictures.

- **Surface smoothness.** The smoothness of the paper affects how crisp the printing looks on the paper. Glossy, coated paper works well for pictures and charts (where you want crisp lines with intense, high-quality colors).

- **Opacity.** Opacity refers to the degree to which printing on one side of the paper shows through to the other side. Use paper high in opacity (or thicker paper) for two-sided printing. HP Premium Brochure and Flyer Paper is ideal for two-sided projects.
Get the Right Paper

Your HP DeskJet printer is designed to work well on most common office paper types and with quality 25% cotton bond paper. Because your printer uses ink to produce an image, paper that accepts ink well produces the best results. Be sure to test a variety of paper types before buying large quantities.

HP papers are available at most computer supply stores. See “Supplies and accessories” on page 66 for paper ordering information.

Paper that Might Not Work

- Highly textured stock, such as linen, might not print evenly; the ink could bleed into these papers.
- Extremely smooth, shiny, or coated papers not specifically designed for inkjet printers could jam the printer and might actually repel ink.
- Multi-part forms (such as duplicate or triplicate forms) could wrinkle in the printer or get stuck; the ink is also more likely to smear. In addition, only the top page is printed.
- Paper in poor condition—with tears, dust, wrinkles, curled or bent edges, or paper that doesn’t lie flat—could jam the printer.
- Envelopes with thick or crooked edges; envelopes that are damaged, curled, wrinkled, or irregularly shaped; envelopes that are shiny or embossed; or envelopes with clasps or windows.
Finding the HP print settings box

After you lay out the page and choose the text, pictures, fonts, and colors from your software program, you need to select settings such as paper type, paper size, orientation, and print quality in the HP print settings box. Where is it?

The way you get there varies depending on the software program and the operating system you’re using. Try these strategies from the File menu of your document, and you’re sure to get there.

Try This...

1. Click File and then click Print.

2. Then click whichever button you see—Setup, Options, or Properties.

...Or Try This

1. If Print isn’t there, click Printer Setup or Print Setup.

2. Then click whichever button you see—Setup or Options.

2. Then click whichever button you see—Properties, Setup, or Printer.
...then click a tab, and then click a setting.

Show your finished work at its best.
Click Best print quality. Best is recommended for photographs printed on photo paper.

Save time and ink.
Click Draft mode. Draft is recommended for printing test pages and proofing drafts.

Select the appropriate paper settings.
Choose the correct paper type and size for the job.

Resize your images.
Click Scale to Fit to resize images formatted for one paper size to fit another paper size.

Enhance your photos.
Click here when you use the HP Photo Cartridge to print sharp, vibrant color photos.

Note: Features and wording on the HP print settings box tabs may differ from that shown here depending on your printer model.

Save money and trees.
Print on both sides of the paper.

Flip the image.
Click Mirror Image. This is great for iron-on transfers.

Save time and color ink.
Click here to print drafts of color documents in shades of gray.

Manage your ink.
Use sliders to adjust the amount of ink on the page.
How to print on standard paper sizes

1. Check your print settings.

   Choose your print settings in the HP print settings box. (See “Finding the HP print settings box” on page 26.)

   Choose print quality, paper size, and paper type on the Setup tab.

   Choose orientation, two-sided printing, multiple page printing, mirror image, and poster printing options on the Features tab.

   Choose color options on the Advanced tab.

   Click the Setup tab.

   First click the down arrow, and then click your selection.

   Click the Features tab.

   Click the Advanced tab.

   Click OK to save.
2 Click OK in the Print box of your software program to save your settings and start printing.

The next time you want to print this document, you can use the Print button at the top of the screen in your software program — simply click it to print one copy using the same print settings.

That’s all there is to it. The printer prints one page at a time until it finishes, delivering each printed page neatly into the printer’s OUT tray.

**While you’re printing**

It takes a few moments for the printing to start, because the printer is receiving information from the computer. During printing, the printer might pause occasionally to receive more information. (Don’t worry, it’s normal.)

**If you run out of paper before you’re finished**

The printer prompts you to add more paper. Load the paper in the IN tray and press Resume [Resume].

**If something goes wrong**

Sometimes, in spite of your best efforts, something goes wrong during printing. Maybe a sheet of paper jams in the printer or nothing happens at all. See “Solving Common Problems” in your Reference Manual.
How to print on different paper sizes

Most of the time, when you print on plain paper, cards, labels, and envelopes, you select one of the standard sizes in the Paper Size box on the Setup tab of the HP print settings box. However, you’re not limited to the sizes listed. Just make sure that the size of the paper falls within the following dimensions (so both of the printer rollers can pick up the paper):

- **Width:** 5 to 8.5 inches (127 to 215 mm) with card guide down
  4 to 8.5 inches (100 to 215 mm) with card guide up
- **Length:** 5.83 to 14 inches (148 to 356 mm)

*Then follow these steps:*

1. In the HP print settings box, click the Setup tab, and then select User Defined Paper Size in the Paper Size list. (See “Finding the HP print settings box” on page 26.)

2. Type the dimensions of the paper in the User Defined Paper Size dialog box, and click OK.

3. Load the paper in the printer, and print as you would for normal paper sizes.

Remember to reset the software for the paper in the IN tray after printing completes.
How to print on both sides of the paper

The easiest way to save paper is to print on both sides. Just put the paper through the printer twice: the first time through it prints the odd-numbered pages and the second time through it prints the even.

1. Load the paper in the IN tray.
   Make sure that there's no paper in the OUT tray.

2. In the HP print settings box, click the Features tab. (See “Finding the HP print settings box” on page 26.)

3. Click Two-Sided Printing, then click Book or Tablet. Use Book when the sheets of your document will be bound on the left. Use Tablet when the sheets of your document will be bound at the top edge.

4. Print your document.
   The printer automatically prints only the odd-numbered pages. The printer then displays a message on your computer screen, telling you how to reload the paper.

5. Load the printed pages back in the IN tray of the printer.
   The following illustrations show how to Load the paper back in the printer for the Book option and the Tablet option.
When the paper is properly loaded into the IN tray, click Continue.

The printer prints the even-numbered pages on the reverse side of the odd-numbered pages.

After printing, remember to uncheck the Two-Sided Printing option on the Features tab.

---

How to create a mirror image of your document

When you print a mirror image, the text and pictures are reversed (mirrored), from what you see on your computer screen.

Print a mirror image when you use an iron-on transfer. The image you print on the transfer paper is flipped back to its original orientation when you iron it onto the cloth. This is especially important if your transfer contains text.

You might want to flip a document before printing it on a transparency: then you can make notes on the back of the transparency and easily wipe them off without scratching the transparency.

1. Load the paper in the IN tray, printable side down.

   If you’re printing transparencies, go to “Printing Transparencies” on page 45. If you’re printing iron-on
transfers, go to “Printing Iron-On Transfers” on page 47.

2 In the HP print settings box, click the Features tab, and then click Mirror Image. (See “Finding the HP print settings box” on page 26.)

3 Print your document.
   The text and pictures are reversed. Hold the printout up to a mirror to see how the final product will look.

   **After printing, remember to:**
   - Click the Mirror Image box again to clear it.
   - If you used transparencies or iron-on transfer paper, replace it with whatever type of paper you’ll be using next.
About color

Your HP DeskJet printer prints in color when a color-capable software program is used with the printing software. Believe it or not, your color printer prints with only four colors—cyan, magenta, yellow, and black. By printing overlapping dots of different intensity and color, it creates practically any color you can imagine.

Your printer is especially smart about printing color. It uses HP’s exclusive technology called PhotoREt™! When you print a document in color, the printer marks each element in your document—text, full-color photographs, and graphics (such as pie charts with solid blocks of color)—and renders each at its vivid best. (If you use the photo cartridge when you print color photographs, you’ll get photo-quality images!) Not only is the color quality high, for whatever you’re printing, but it’s also less expensive than making color copies at a copy shop.

How to turn off color

The color text and pictures that you create in your documents automatically print in color. You can print drafts of your documents in grayscale if you’re going to photocopy them in black and white, or if you want to save time and ink.

• In the HP print settings box, click the Advanced tab, and then click Print in Grayscale. (See “Finding the HP print settings box” on page 26.)

A “✓” means that color is turned off.

Now your color documents print in shades of gray until you clear this setting.
About pictures

Pictures (also called *graphics*) include photographs, illustrations, charts, and decorative elements.

How to get a picture on your computer

To put a picture in a computer document, you first need to convert it into an electronic form (a computer file). Then it’s simple to copy it into a document—the guide for the application you’re using tells you how. Here are some possibilities for getting your pictures into an electronic form:

- Draw the pictures, using the drawing tools in a software application.
- Use ready-made clip art. You can purchase libraries of clip art from a variety of sources or browse the Internet for what’s available there. Look through computer magazines for the names of companies that sell clip art. They’ll be happy to send you full-color pictures of their extensive offerings. Or browse in the art sections of bookstores for books of copyright-free pictures.
- Scan the pictures yourself. Use your own scanner and its instructions. Save the files onto a hard disk, floppy disk or CD. Open your software program and follow its instructions to import the file into your document.

Remember that it is against the law to copy any photograph unless you have been given specific permission to do so by the person or company who owns the original.
- Get your photos scanned at your local camera shop. For a small fee, you can have an entire roll of photos put on a CD or floppy disk. Be sure to ask your camera shop to also put a CD-viewing program on the CD with your photos. Open your software program and follow its instructions to import the file from floppy disk or CD into your document.

- Take a digital photo. A digital camera bypasses film entirely and turns the photo into a computer file.
Beyond the Basics

With the printing basics down, you’re ready for some results. Here are some ideas for printing on different paper types.

- **Photographs**—make personalized buttons, name tags, or photographic calendars.
- **Envelopes**—either one at a time or as a stack.
- **Greeting cards, business cards, recipe cards, or invitations to opening night.**
- **Labels**—scan your logo in full color, and add it to your company address to print distinctive labels for packages and manila envelopes.
- **Transparencies** for that important overhead presentation.
- **Make a big statement**—print posters to announce the company picnic.
- **Iron-on transfers** on t-shirts printed with your company logo.
Printing Photographs

Printing photographs is similar to printing any other color image. The main differences are paper and print quality selections. Each time you print a photograph, you replace the black print cartridge with the photo cartridge.

For best results when printing photographs, use one of HP's photo papers. For a list of available photo paper products and ordering information, see page 68.

1 With the printer turned on, open the top cover.

   The cartridge cradles move to an accessible position and the Resume light flashes.

2 Pull the top of the black print cartridge toward you until it pops loose. Lift it from its cradle.

3 Store the black print cartridge in the print cartridge storage container.

4 Place the photo cartridge into the now-empty cartridge cradle. Align the arrow on the print cartridge with the notch on top of the cradle, and push the arrow toward the notch until the print cartridge snaps into place.

   You hear a click when the cartridge sits snugly in its cradle.

5 Close the printer's top cover.

6 The cradles return to their home position on the right side of the printer and the Resume light stops flashing.
7 Align the cartridges. See “Aligning the print cartridges” on page 63 for instructions.

8 In the Setup tab of the HP print settings box, select a photo paper for the Paper Type. (See “Finding the HP print settings box” on page 26.)

9 Make sure Best print quality is selected. When you select an HP photo paper, this option is automatically selected.

10 Check HP Photo Cartridge.

11 Load the paper as you would for normal printing.

   Make sure you insert the paper printable side down.

   ![Image of paper being loaded](image)

   **Printable side down**

12 Print the document.

   For the best results, remove each sheet promptly after printing, and allow it to dry printable side up. (The drying time will vary depending on the humidity.)

**After printing, remember to:**

- Remove any special paper you’ve used from the IN tray and replace it with whatever you’ll be printing on next.
- Remove the photo cartridge and replace it with the black print cartridge. Store the photo cartridge in the storage container.
- Reset the software for the paper you’ll be printing on next.
Printing Envelopes

Your printer provides two methods for printing envelopes:

- If you’re printing a single envelope, you can use the single-envelope slot and leave your paper in the IN tray. This allows you to print the envelope and then a letter.
- If you’re printing a stack of envelopes, use the IN tray.

Avoid shiny or embossed envelopes, or those that have clasps or windows. (Use transparent labels instead for these sorts of envelopes.) Also, envelopes with thick, irregular, or curled edges or with areas that are wrinkled, torn, or otherwise damaged could get stuck in the printer.

Many programs include a feature for printing envelopes. In that case, follow the program’s instructions for setup and for placing the envelopes in the printer.

How to print a single envelope

1. In the HP print settings box, click the Setup tab, and then select an envelope size in the Paper Size box. (See “Finding the HP print settings box” on page 26.)
2. Slide the envelope into the single-envelope slot, as shown here, until it stops. Make sure there’s paper in the IN tray. Make sure the edge of the envelope aligns with the right side of the single envelope slot.

Flap side up and flap to the right

Note: When printing a single JIS #4 (90 x 205 mm) envelope, do NOT use the single-envelope slot. Instead, follow instructions on page 42 for printings cards.

3. Print the envelope.
How to print a stack of envelopes

1. In the HP print settings box, click the Setup tab, and then select the envelope you’re printing on as the Paper Size. (See “Finding the HP print settings box” on page 26.)

2. Slide both paper adjusters out.
   Make sure the IN tray is empty.

3. Load a stack of up to 20 envelopes in the printer, as shown here. (If you’re using thick envelopes, you might need to reduce the quantity.)

   **Note:** When printing a stack of JIS #4 (90 x 205 mm) envelopes, follow instructions on page 42 for printing cards.

4. Slide the paper adjusters so that they fit snugly against the edges of the envelopes.

   **Note:** When printing JIS #3 envelopes (120 x 235 mm), make sure the flap is up and toward you.

5. Print the envelopes.
About small envelopes

If you’re printing on small envelopes such as Invitation A2, C6, or JIS #4, you’ll need to lower the handle on the paper-length adjuster so that it slides under the OUT tray.

Make sure the envelopes do not bend in the IN tray.

After printing, remember to:

- Reset the software for the paper you’ll be printing on next.
- Remove any remaining envelopes from the IN tray and replace them with whatever paper you’ll be printing on next.

Printing Cards

Use your printer to print on index cards, recipe cards, greeting cards, business cards, or postcards—or any card size included in the Paper Size list on the Setup tab. You can print on other sized cards, too. If the dimensions of your card aren’t the same as those shown in the Paper Size list, see “How to print on different paper sizes” on page 30.

1. In the HP print settings box, click the Setup tab, and then select a card in the Paper Size drop-down box. (See “Finding the HP print settings box” on page 26.)
2. Remove the OUT tray and raise the card guide.
3 Load a stack of up to 30 cards in the IN tray. Make sure the right edge of the card stack rests against the raised card guide.

**Note:** When printing JIS #4 (90 x 205 mm) envelopes, make sure the flap is up and toward you.

4 Lower the handle of the paper length adjuster so that it doesn't interfere when replacing the OUT tray.

5 Slide the paper adjusters so that they fit snugly against the cards.

6 Replace the OUT tray. You might need to lift the top cover a little to do this.

7 Print the cards.

**After printing, remember to:***
- Return the card guide to the down position.
- Remove any cards from the IN tray and replace them with whatever paper you'll be printing on next.
- Reset the software for the paper you'll be printing on next.
**Printing Labels**

You can use your HP DeskJet printer to print sheets of labels. Use only A4 or U.S. letter-sized sheets of labels. It’s particularly important to pick labels that are made especially for inkjet printers.

Sheets of labels that are folded, curled, wrinkled, or partially used can get stuck in the printer.

1. Click the Setup tab in the HP print settings box. Select Plain Paper as the Paper Type. (See “Finding the HP print settings box” on page 26.)
2. Then select Normal as the Print Quality.
3. Fan the edges of the label sheets to separate them.
4. Load up to 25 label sheets on top of about 5 sheets of plain paper of the same size.
5. Slide the paper adjusters to fit snugly against the stack.
6. Print the labels.

**After printing, remember to:**
- Leave the settings as they are if you’re going to be printing on plain paper.
- Remove the label sheets from the IN tray and replace them with whatever paper you’ll be printing on next.
Printing Transparencies

For best results, use HP Premium Inkjet Rapid-Dry Transparencies or transparencies specifically designed for inkjet printers, for your overhead presentations.

1 In the HP print settings box, click the Setup tab, then select HP Premium Inkjet Transparency Film, HP Premium Inkjet Rapid-Dry Transparency, or Other Transparency Films as the Paper Type. (See “Finding the HP print settings box” on page 26.)

2 Make sure Best is selected as the Print Quality.
   It isn’t absolutely necessary to use the Best Print Quality, but it’ll give you the best results. If you’re in a hurry, use Normal Print Quality.

3 If you plan to make notes on your transparencies during your presentation, click the Features tab, then select Mirror Image.

4 Put up to 25 sheets of transparencies in your printer with the rough side down and the adhesive strip forward. (You can peel off the adhesive strip after printing.)

5 Slide in the paper adjusters, just as you would for plain paper.

6 Print the transparency.

7 Be patient.
   Because the printer uses more ink, lays the colors down more slowly, and allows for a longer drying time between sheets, transparencies take awhile to print.

After printing, remember to:

- Remove any remaining transparencies from the IN tray and replace them with whatever paper you’ll be printing on next.
- Reset the software for the paper you’ll be printing on next.
Printing Posters

When you print posters, the text and pictures of each page of your document are magnified and printed across the selected sheets of paper.

1. Load U.S. letter- or A4-sized paper in the IN tray.
2. Slide paper guides snugly against the sheets.
3. Click the Setup tab in the HP print settings box. Select Plain Paper as the Paper Type. (See “Finding the HP print settings box” on page 26.)
4. Select Normal as the Print Quality.
5. Click the Features tab. Check Poster Printing, and then choose 2x2, 2x3, or 4x4.
6. Print your poster.
7. After the document has printed, trim off the white edges on each sheet. Tape the sheets together to form a poster.

After printing, remember to:
- Reset the software for the paper you’ll be printing on next.
Printing Iron-On Transfers

When it comes to printing images, you don’t need to stop with paper. Use transfer paper to get the images from the computer document onto cloth. HP Iron-On T-Shirt Transfers are designed to work with your printer and HP ink to give you a professional silk screen look.

Although 100% cotton t-shirts are a popular choice for iron-on transfers, you need not stop there. Transfer a photo onto an apron, or add the company logo to baseball caps, sun visors, and tote bags for the company picnic.

You’ll need:
- the t-shirt or other cloth you want to transfer an image onto
- the document containing the picture or text you want to print
- iron-on transfer paper

Here’s how you do it:
1. On your computer, open the document containing the text or picture you want to transfer to the fabric.
2. In the HP print settings box, click the Setup tab. Select HP Iron-on T-Shirt Transfers as the paper type. (See “Finding the HP print settings box” on page 26.)
3. If you want the text or picture on your t-shirt as you see it on the screen, flip the document by clicking Mirror Image on the Features tab.
4. Put the transfer paper transparent-side down in the printer.
5. Print the transfer.
6. Follow the instructions included with the iron-on transfer paper to transfer the image onto the fabric.

After printing, remember to:
- Replace the transfer paper with whatever paper you’ll be printing on next.
- Reset the software for the paper you’ll be printing on next.
Getting Help

HP Customer Care

HP DeskJet printers set the standard for quality and reliability, so you have made an excellent choice. Should you need help, however, HP Customer Care’s award-winning service and support is nearby to provide expert advice on using your HP printer or to answer specific questions about a problem you are having. Whether online or by phone, you’ll find the support you need—and you’ll find it fast.

HP Customer Care Online

Click your way to a quick solution! HP Customer Care Online is a great place to go for answers to questions about your HP products. You’ll get instant access to everything from helpful printing tips to the latest product and software updates—24 hours a day, seven days a week, all at no charge to you.
If you have a modem connected to your computer and subscribe to an online service or have direct access to the Internet, you can obtain a wide variety of information about your printer at the following web sites:

- **English:** http://www.hp.com/support/home_products
- **French:** http://www.hp.com/cposupport/fr
- **German:** http://www.hp.com/cposupport/de
- **Japanese:** http://www.jpn.hp.com/CPO_TC/eschome.htm
- **Korean:** http://www.hp.co.kr/go/support
- **Portuguese:** http://www.hp.com/cposupport/pt
- **Simplified Chinese:** http://www.hp.com.cn/go/support
- **Spanish:** http://www.hp.com/cposupport/es
- **Traditional Chinese:** http://support.hp.com.tw/psd

From HP Customer Care Online you can link to HP Customer Care User Forums and HP Customer Care Email.

**HP Customer Care User Forums**

They’re friendly. They’re informative. Check out our online user forums. Simply review existing messages left by other HP users to find the answers you’re looking for. You can also post your questions, then check back later for ideas and suggestions from knowledgeable users and system operators.

**HP Customer Care by Email**

Connect with HP via email and receive a personal reply from an HP Customer Care service technician. Responses are normally provided within 24 hours of receipt (excluding holidays). A great option for those non-urgent questions.
**Printer Software**

Printer software (also referred to as a printer driver) allows your printer to talk with your computer. HP provides printer software and software updates for Windows 3.1x, 95, 98, NT 4.0, and Windows 2000. For MS-DOS printer software, contact the manufacturer of your software program. You have several options for getting printer software:

<table>
<thead>
<tr>
<th>First time setup?</th>
<th>In the U.S. and Canada</th>
<th>Elsewhere in the world</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Download the printer software by accessing the HP Customer Care Online web site. See page 49 for HP web site addresses.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create diskettes by using another computer with a CD-ROM drive. To create the diskettes, begin the printer software installation. When the opening screen appears, select <strong>Make diskettes of your printer software</strong> and follow the on-screen instructions.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Call (661) 257-5565 to order 3.5-inch diskettes. Nominal shipping and handling charge may apply. Bonus software that may be provided on the CD will not be provided on disks.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Need software update?</th>
<th>In the U.S. and Canada</th>
<th>Elsewhere in the world</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Download the printer software from the HP Customer Care Online web site. See page 49 for HP web site addresses.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Call (661) 257-5565 to order 3.5-inch diskettes. Software updates are available for the cost of the CDs or diskettes plus shipping.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Download the printer software from the HP Customer Care Online web site. See page 49 for HP web site addresses.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Call the HP Customer Care Center nearest you. See page 51 for phone numbers.</td>
<td></td>
</tr>
</tbody>
</table>
HP Customer Care by Phone

Region | Phone Support *
---|---
DeskJet 640C Series | Fee based
North America (Including Canada) | Fee based
Asia Pacific | 90 days
Europe | 90 days
Latin America | 1 year

*Long distance charges may apply in different regions.*

Before placing a call for help, please make sure that:

2. You have checked [HP Customer Care Online](http://www.hp.com/support) for product help. See page 49 for HP web site addresses.
3. If you cannot solve your problem using the above, then call an HP service technician while you’re in front of your computer and printer. Before you call, be sure you have the following information:
   - Your printer’s serial number (the label is on the printer’s bottom).
   - Your printer’s model number (the label is on the front of the printer).
   - The model of the computer.
   - The version of the printer and software program (if applicable).

Then we can help you with your questions immediately!
See the list below for your country’s HP Customer Care Center phone number:

<table>
<thead>
<tr>
<th>Country</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Africa/Middle East</td>
<td>41 22/780 41 11</td>
</tr>
<tr>
<td>Argentina</td>
<td>(541) 778-8380</td>
</tr>
<tr>
<td>Australia</td>
<td>+61 3 8877 8000</td>
</tr>
<tr>
<td>Austria</td>
<td>43 (0) 660 6386</td>
</tr>
<tr>
<td>Belgium (Dutch)</td>
<td>32 (0)2 62688 06</td>
</tr>
<tr>
<td>Belgium (French)</td>
<td>32 (0)2 62688 07</td>
</tr>
<tr>
<td>Brazil</td>
<td>011 829-6612</td>
</tr>
<tr>
<td>Canada</td>
<td>(905) 206-4663</td>
</tr>
<tr>
<td>Chile</td>
<td>800 36 0999</td>
</tr>
<tr>
<td>China</td>
<td>8610-65645959</td>
</tr>
<tr>
<td>Czech Republic</td>
<td>42 (0) 471 7321</td>
</tr>
<tr>
<td>Denmark</td>
<td>45 (0) 39 294099</td>
</tr>
<tr>
<td>Finland</td>
<td>358 (9) 2034 7288</td>
</tr>
<tr>
<td>France</td>
<td>33 (0) 143623434</td>
</tr>
<tr>
<td>Germany</td>
<td>49 (0) 180 532 6222</td>
</tr>
<tr>
<td>Greece</td>
<td>30 1 689 64 11</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>(800) 96 7729</td>
</tr>
<tr>
<td>Hungary</td>
<td>36 (1) 252 4505</td>
</tr>
<tr>
<td>India</td>
<td>91 11 682 60 35</td>
</tr>
<tr>
<td>Indonesia</td>
<td>6221 350 3408</td>
</tr>
<tr>
<td>Ireland</td>
<td>353 (0) 1662 5525</td>
</tr>
<tr>
<td>Israel</td>
<td>972-9-9524848</td>
</tr>
<tr>
<td>Italy</td>
<td>39 (0) 2 264 10350</td>
</tr>
<tr>
<td>Japan, Osaka</td>
<td>81 6 6838 1155</td>
</tr>
<tr>
<td>Japan, Tokyo</td>
<td>81 3 3335-8333</td>
</tr>
<tr>
<td>Korea</td>
<td>02 3270 0700</td>
</tr>
<tr>
<td>Malaysia</td>
<td>03 2952566</td>
</tr>
<tr>
<td>Mexico D.F.</td>
<td>258 9922</td>
</tr>
<tr>
<td>Mexico, Guadalajara</td>
<td>01 800 472 6684</td>
</tr>
<tr>
<td>Middle East/Africa</td>
<td>41 22/780 41 11</td>
</tr>
<tr>
<td>Netherlands</td>
<td>31 (0) 20 606 8751</td>
</tr>
<tr>
<td>New Zealand</td>
<td>(09) 356-6640</td>
</tr>
<tr>
<td>Norway</td>
<td>47 (0) 22 116299</td>
</tr>
<tr>
<td>Philippines</td>
<td>65 272 5300</td>
</tr>
<tr>
<td>Poland</td>
<td>(+48) 22 519 06 00</td>
</tr>
<tr>
<td>Portugal</td>
<td>351 (0) 1 318 00 65</td>
</tr>
<tr>
<td>Russia</td>
<td>7095 923 50 01</td>
</tr>
<tr>
<td>Singapore</td>
<td>65 272 5300</td>
</tr>
<tr>
<td>Spain</td>
<td>34 (9) 02321 123</td>
</tr>
<tr>
<td>Sweden</td>
<td>46 (0) 8 6192170</td>
</tr>
<tr>
<td>Switzerland</td>
<td>41 (0) 84 8801111</td>
</tr>
<tr>
<td>Taiwan</td>
<td>886 2-2717-0055</td>
</tr>
<tr>
<td>Thailand</td>
<td>(66-2) 661 4011</td>
</tr>
<tr>
<td>Turkey</td>
<td>90 1 224 59 25</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>44 (0) 171 512 5202</td>
</tr>
<tr>
<td>U.S.</td>
<td>(208) 344-4131</td>
</tr>
<tr>
<td>Venezuela</td>
<td>800 47 888</td>
</tr>
<tr>
<td>Venezuela, Caracas</td>
<td>207 8488</td>
</tr>
</tbody>
</table>
After the Free Phone Support Period
You can still get help from HP for a fee. Prices are subject to change without notice. HP Customer Care Online help (page 49) on the internet is still available for free!

- For quick questions in the United States only, call (900) 555-1500. The charges are $2.50 per minute and begin when you connect with a service technician.
- For calls from Canada, or for calls in the U.S. that you anticipate might be longer than ten minutes in length, call (800) 999-1148. The fee is US $25 per call, charged to your Visa or MasterCard.
- If, during your phone call, it is determined that your printer requires repair and you are within your printer’s Limited Warranty period (see the “Limited Warranty Statement” in your Reference Manual), you will not be charged for the phone support service. However, for countries where the above toll-free phone numbers are not available, the regular long-distance charges may apply.
- If you are outside the U.S. and Canada, call the HP Customer Care Center nearest you.

Extended Warranty Options
If you would like to extend your printer coverage beyond the limited warranty period, you have the following options:

- Consult your reseller to get extended coverage.
- If your reseller does not offer service contracts, please call HP directly and ask about our HP Service Agreements. In the U.S., call (800) 446-0522; in Canada, call (800) 268-1221. For HP Service Agreements outside the U.S. and Canada, contact your local HP Sales Office.

HP Customer Care Repair
If your HP printer is ever in need of repair, simply call the HP Customer Care Center. A trained service technician will diagnose the problem and coordinate the repair process for you. This service is free during your printer’s limited warranty period. Beyond the warranty period, repairs are charged on a time and materials basis.
Until now, we’ve been talking about the what, where, and how of your printer. If you’re ready for some simple facts about the printer and printer supplies, here they are.

**The HP DeskJet Toolbox**

Use the HP DeskJet Toolbox for cleaning your printer, finding information, and printing a test page. To find the HP Toolbox, follow the instructions for your Windows system.

**For Windows 95, 98, and Windows NT 4.0**
- Click Start → Programs → HP DeskJet 640C Series → HP DeskJet 640C Series Toolbox.
- OR—
- Click the HP Toolbox button that appears on the Taskbar at the bottom of the screen when the HP Toolbox is open.

Click an option, then follow on-screen instructions.

- Click here to open the User’s Guide.
- Click here to align the print cartridges.
- Click here to clean the print cartridges.
- Click here to print a test page.
- Click here to order print cartridges online or locate stores near you.
Windows 3.1x

- Double-click the HP Toolbox icon in the HP DeskJet Utilities group in the Program Manager.

-OR-

- Double-click the HP Toolbox icon. It’s on the desktop when you start your computer.

Print cartridges

Each HP print cartridge is a self-contained, plug-in ink supply. The printer operates with two print cartridges installed: one black and one tri-color. The HP printers and print cartridges are designed to work together to deliver outstanding print quality for results that are always clear, always sharp.

Replacing print cartridges

Note: When buying print cartridges, check the part numbers referenced below carefully to make sure you are buying the right print cartridges for your printer:

- Black HP No. [15] (equivalent to C6614 Series)
- Tri-Color HP No. [49] (equivalent to 51649 Series)
- HP Photo Cartridge C1816

Note: When a print cartridge runs out of ink, leave the empty cartridge in the cradle until you can replace it. The printer cannot print with only one print cartridge installed.
To replace a print cartridge:
1. Press the Power button to turn on the printer.
   The Power light comes on.
2. Open the top cover.
   The print cartridge cradle moves to an accessible position,
   and the Resume light flashes.
3. Grasp the top of the empty print cartridge, pull it toward you
   until it pops loose. Lift the print cartridge out of the cradle
   and discard it.
   
   **Warning** Keep new and used print cartridges out of the
   reach of children.

4. Remove the replacement print cartridge from its packaging
   and carefully remove the protective vinyl tape from the print
   cartridge.

   ![Cartridge cradle](image)
   ![Resume light (flashes)](image)
   ![Power light (on)](image)

   **Warning** Do NOT touch the print cartridge ink nozzles or
   copper contacts. Touching these part will result in clogs, ink failure,
   and bad electrical connections. Also, do NOT remove the copper strips;
   these are required electrical contacts.

5. Place the replacement cartridge into its cradle. You must
   insert both print cartridges for the printer to operate.
Align the arrow on the print cartridge with the notch on top of the cradle, and push the arrow toward the notch until the print cartridge snaps into place.

6 Close the top cover.

The Resume light continues to blink for awhile and then goes off. (You’ll hear the cartridge cradle return to its home position on the right side of the printer.)

7 If the Resume light continues to blink after you install new print cartridges, check the part numbers on the cartridges to ensure you installed the correct ones.

Storing print cartridges

To maintain excellent print quality from your print cartridges:

- Keep all print cartridges in their sealed packages, at room temperature (60-78 degrees F or 15.6-26.6 degrees C), until you are ready to use them.
- Once installed, leave the print cartridges in their cradle at all times to keep them from drying out or becoming clogged.
- Store unsealed print cartridges in an airtight plastic container.
- Do not unplug the printer until printing is complete and the print cartridge cradle has returned to its home position on the right side of the printer. The print cartridges will dry out if not stored in their home position.
- Turn off the printer and allow the print cartridges to return to the right side of the printer for proper capping of the nozzles before unplugging the power cord or turning off any attached power strip.
Cleaning the print cartridges

Cleaning your print cartridges can improve the quality of printing.

If your printed page is missing lines or dots, perform Procedure 1 below. If your printed page contains streaked ink, perform Procedure 2.

Procedure 1: Correcting missing lines or dots

Clean the print cartridges when you notice that the lines or dots are missing from your printed text and graphics, as shown here. The print cartridges can be cleaned from the HP Toolbox.

To clean the print cartridges from the HP Toolbox:

1. Open the HP DeskJet Toolbox. See “The HP DeskJet Toolbox” on page 54 for instructions on how to find it.
2. Click the Printer Services tab.
3. Click Clean the Print Cartridges and follow the directions on the screen.

If print quality improves by going through this sequence once, but the quality is still not quite good enough, repeat the procedure. Click the Clean Again button on the last cleaning screen.

If the preceding procedure does not improve the print quality, your print cartridges might be low on ink. Replace the print cartridges (see page 55). If problems persist, continue with Procedure 2.

Note: Do not clean the print cartridges unnecessarily, as this wastes ink and shortens the life of the print cartridge.
Procedure 2: Eliminating ink streaks

Customers using HP DeskJet printers in dusty environments might occasionally experience ink streaks or smearing because of a small accumulation of debris inside the printer. This debris can include dust, hair, carpet, or clothing fibers. Ink streaking is easily prevented or corrected by doing scheduled cleaning to two areas of the printer: the print cartridges, and the print cartridge cradle.

Materials you will need

Before you begin, make sure you have the following materials available:

- Cotton swabs or any soft material that will not come apart or leave fibers (for example, a piece of clean cotton cloth).
- Distilled, filtered, or bottled water (tap water might contain contaminants that can damage the print cartridges).
- Scrap paper or paper towel on which to set the print cartridges while you are working.

Caution: Be careful not to get ink on your hands or clothing.

Steps to manually clean your print cartridges and print cartridge cradle:

1. Remove the print cartridges
   a. Turn the printer on and lift the printer’s top cover.
   b. The print cartridge cradle moves to an accessible position.
   c. After the cradle has moved, unplug the power cord from the back of the printer.
d. Remove the print cartridges and place them on their sides on a scrap piece of paper.

**Warning** Keep new and used print cartridges out of the reach of children.

**Caution** Once you’ve removed the print cartridges, make sure that they are not outside of the printer for more than 30 minutes.

**Note:** Be careful not to touch the ink nozzles or the copper contacts. Touching these parts of the print cartridge can result in clogs, ink failure, or bad electrical connections.

2. Clean the print cartridges
   a. Dip a clean cotton swab into distilled water and **squeeze** any excess water from the swab.
   b. Grasp the black print cartridge by the colored cap.
   c. Clean the **face** and **edges** of the print cartridge as shown. **DO NOT** wipe the nozzle plate.
   
   ![Diagram of print cartridge]

   d. Hold the print cartridge up to the light to inspect for fibers on the face and edges. If fibers are still present, repeat steps 2a through 2c.
   e. Repeat steps 2a through 2d with the tri-color print cartridge using a clean, moistened cotton swab to avoid any contamination.
3 Clean the print cartridge cradle
   a. Position yourself at eye level with the printer.
   b. Locate the cradle that holds the print cartridges, then locate the three black, hook-shaped arms on the bottom of the cradle.
   c. Using clean, moistened swabs, wipe the flat surfaces (shaded area) on the undersides of each arm from back to front. Repeat until no ink residue is seen on a clean swab.

4 Clean the service station
   a. Using a clean, moistened swab, clean the rim of the sponge holder.
   b. Remove any built-up ink and fibers from the top of the sponge. If the sponge is higher than the rim, use the cotton swab to push it below the rim.
   c. Using a clean, moistened swab, clean wiper 1 and the top surface of cap 1.
   d. Using a clean, moistened swab, clean wiper 2 and the top surface of cap 2.

   **Caution**  Use light force when cleaning the print cartridge caps. Heavy force might unseat the caps, eventually causing damage to the print cartridges.
5 Reinstall the print cartridges
   a. Reinstall the print cartridges and close the printer’s top cover.
   b. Reinsert the power cord into the back of the printer.
   c. Print a test page. On the Printer Services tab of the HP Toolbox, click Print a Test Page.
   d. Examine the printout for ink streaking.

**Note:** This procedure should remove all fibers that would cause ink to streak on a printout. However, fibers can be missed. If the printout still shows streaking, repeat the procedure until the test printout is clear and sharp. This procedure and additional maintenance tips are located on the HP Customer Care Web site at: http://www.hp.com/support/home_products.

**Damage resulting from refilling the print cartridges**

To get the best performance from your printer, Hewlett-Packard recommends using only genuine HP supplies for HP inkjet printers, including genuine factory-filled HP print cartridges.

**Caution** Damage resulting from the modification or refilling of HP print cartridges is specifically excluded from the coverage of HP printer warranties.

**Note:** When buying replacement print cartridges, check the part numbers carefully so that you buy the right cartridges for your printer (see page 55).
Aligning the print cartridges

You must use the printer software to align the black, tri-color, and photo print cartridges each time you replace or reinstall a print cartridge. This ensures that the black and tri-color inks are aligned when used together on the same line of text or within the same picture.

1. Make sure the printer is on and the Power light is lit.
2. Be sure the printer’s IN tray contains plain paper.
3. Open the HP DeskJet Toolbox. (Go to “The HP DeskJet Toolbox” on page 54.)
4. Click the Printer Services tab. Then click Align the Print Cartridges. Follow the directions on the computer screen.

Maintaining your printer

- Use a soft cloth moistened with water to wipe off dust, smudges, and stains.
- The interior of the printer does not require cleaning. Keep fluids away from the interior of the printer.
- Do not lubricate the rod on which the print cartridge cradles move. Noise is normal when the cradle is moving back and forth within the printer, when the printer is new. With use, the printer will become quieter.
Increasing printer performance

The print speed and overall performance of your printer can be affected by several things:

- The amount of RAM in your computer can determine how fast your documents are sent to the printer. Increasing the amount of RAM in your computer can speed up this process as well as make your computer work more efficiently when you are doing something besides printing.

- The processing speed of your computer determines how fast your document is sent to the printer.

- The amount of free space on your computer’s hard disk makes a difference in printing speed. If your computer has less than 100 MB of free space, it can take longer to process your document for printing.

- Running numerous software programs at one time slows down printing, because they are using the RAM in your computer. Therefore, limit the number of programs or documents you open at one time.

- The printer driver that you are using to print your documents can make a significant difference in the quality of your printed output. Make sure you are using an up-to-date version of an HP printer driver designed specifically for your printer model. Go to “Printer Software” on page 50 for information on how to get an updated printer driver.

- The size and complexity of the documents you print can make a difference in your printer’s performance. Graphics and photographs are usually more complex and print more slowly than a document that contains only text.
Minimum printing margins

The printer cannot print outside a certain area of the page, so you must make sure the contents of your document fall within the printable area—that is, within the top, bottom, left, and right margins available for the specific size paper on which you are printing.

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Left and Right Margins</th>
<th>Top Margin</th>
<th>Bottom Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4-sized</td>
<td>3.4 mm</td>
<td>1.0 mm</td>
<td>14.9 mm</td>
</tr>
<tr>
<td>Letter-, Legal, and Executive-sized</td>
<td>0.25 in.</td>
<td>0.04 in.</td>
<td>0.59 in.</td>
</tr>
<tr>
<td>A5-sized</td>
<td>3.2 mm</td>
<td>1.0 mm</td>
<td>21.2 mm</td>
</tr>
<tr>
<td>B5-sized</td>
<td>4.2 mm</td>
<td>1.0 mm</td>
<td>21.2 mm</td>
</tr>
<tr>
<td>Cards (3x5 in, 4x6, 5x8)</td>
<td>0.125 in.</td>
<td>0.04 in.</td>
<td>0.84 in.</td>
</tr>
<tr>
<td>Cards (A6)</td>
<td>3.2 mm</td>
<td>1.0 mm</td>
<td>21.2 mm</td>
</tr>
<tr>
<td>Hagaki postcards</td>
<td>4.2 mm</td>
<td>1.0 mm</td>
<td>21.2 mm</td>
</tr>
</tbody>
</table>

**Note:** DOS margins can vary. See the manual for the specific DOS program for information.

System Requirements

Be sure your computer meets these system requirements.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Minimum Processor Speed</th>
<th>Required RAM</th>
<th>Required Free Hard-disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows NT 4.0</td>
<td>Pentium 66 MHz</td>
<td>32 MB</td>
<td>40 MB</td>
</tr>
<tr>
<td>Microsoft Windows 95 or 98</td>
<td>Pentium 66 MHz</td>
<td>16 MB</td>
<td>40 MB</td>
</tr>
<tr>
<td>Windows 3.1x</td>
<td>Pentium 66 MHz</td>
<td>8 MB</td>
<td>40 MB</td>
</tr>
<tr>
<td>MS-DOS Version 3.3 or greater</td>
<td>486 Processor</td>
<td>4 MB</td>
<td>5 MB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Left Margins</th>
<th>Right Margins</th>
<th>Top &amp; Bottom Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelopes</td>
<td>.21 mm (.084 in.)</td>
<td>1 mm (.04 in.)</td>
<td>3.2 mm (.125 in.)</td>
</tr>
</tbody>
</table>
Supplies and accessories

For ordering information, see page 68.

<table>
<thead>
<tr>
<th>Parts/Supplies Accessories</th>
<th>HP Reorder Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Cartridges</strong></td>
<td></td>
</tr>
<tr>
<td>Black print cartridge</td>
<td>C6614 Series</td>
</tr>
<tr>
<td>Tri-Color print cartridge</td>
<td>51649 Series</td>
</tr>
<tr>
<td>Photo cartridge</td>
<td>C1816 Series</td>
</tr>
</tbody>
</table>

*When you buy replacement cartridges, check the part numbers carefully so that you buy the correct one.*

<table>
<thead>
<tr>
<th>Parts/Supplies Accessories</th>
<th>HP Reorder Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Universal Power Adapter</td>
<td>0950-3490</td>
</tr>
</tbody>
</table>

**Power Cords**

- U.S., Canada, Brazil, Latin America, Saudi Arabia: 8120-6313
- Korea: 8120-8441
- Australia: 8120-6312
- Argentina: 8120-8367
- Japan: 8120-6316
- South Africa, India: 8120-6317
- U.K., Middle East: 8120-6315
- Europe, Jordan, Lebanon, Israel, North Africa, Baltic countries, Russia, Thailand, Indonesia, Caribbean, Latin America: 8120-6314
- China, Taiwan, Philippines: 8120-8373
- Singapore, Hong Kong, Malaysia: 8120-8669

<table>
<thead>
<tr>
<th>Cables</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>HP IEEE-1284-compliant Parallel Interface Cable (with one 1284-A connector for the computer port and one 1284-B connector for the printer port)</td>
<td></td>
</tr>
<tr>
<td>2-meter length</td>
<td>C2950A</td>
</tr>
<tr>
<td>3-meter length</td>
<td>C2991A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parts/Supplies Accessories</th>
<th>HP Reorder Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Photo Color Kits</td>
<td></td>
</tr>
<tr>
<td>Asian HP Photo Color Kit</td>
<td>C4583A</td>
</tr>
<tr>
<td>European HP Photo Color Kit</td>
<td>C4584A</td>
</tr>
<tr>
<td>Latin America HP Photo Color Kit</td>
<td>C4590A</td>
</tr>
<tr>
<td>U.S. HP Photo Color Kit</td>
<td>C4585A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parts/Supplies Accessories</th>
<th>HP Reorder Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Manuals for Windows</td>
<td></td>
</tr>
<tr>
<td>Most HP printer documentation is available for viewing and printing at <a href="http://www.hp.com/support/home_products">http://www.hp.com/support/home_products</a></td>
<td></td>
</tr>
<tr>
<td>Arabic: C6464-90004</td>
<td></td>
</tr>
<tr>
<td>Czech: C6464-90005</td>
<td></td>
</tr>
<tr>
<td>Danish: C6464-90004</td>
<td></td>
</tr>
<tr>
<td>Dutch: C6464-90004</td>
<td></td>
</tr>
<tr>
<td>English: Request number with order</td>
<td></td>
</tr>
<tr>
<td>Finnish: C6464-90004</td>
<td></td>
</tr>
<tr>
<td>French: Request number with order</td>
<td></td>
</tr>
<tr>
<td>German: C6464-90004</td>
<td></td>
</tr>
<tr>
<td>Greek: C6464-90005</td>
<td></td>
</tr>
<tr>
<td>Hebrew: C6464-90005</td>
<td></td>
</tr>
<tr>
<td>Hungarian: C6464-90005</td>
<td></td>
</tr>
<tr>
<td>Italian: C6464-90004</td>
<td></td>
</tr>
<tr>
<td>Japanese: C6464-90010</td>
<td></td>
</tr>
<tr>
<td>Korean: C6464-90007</td>
<td></td>
</tr>
<tr>
<td>Norwegian: C6464-90004</td>
<td></td>
</tr>
<tr>
<td>Polish: C6464-90005</td>
<td></td>
</tr>
<tr>
<td>Portuguese: Request number with order</td>
<td></td>
</tr>
<tr>
<td>Russian: C6464-90005</td>
<td></td>
</tr>
<tr>
<td>Simplified Chinese: C6464-90009</td>
<td></td>
</tr>
<tr>
<td>Spanish: Request number with order</td>
<td></td>
</tr>
<tr>
<td>Swedish: C6464-90004</td>
<td></td>
</tr>
<tr>
<td>Traditional Chinese: C6464-90008</td>
<td></td>
</tr>
<tr>
<td>Turkish: C6464-90005</td>
<td></td>
</tr>
<tr>
<td>Parts/Supplies Accessories</td>
<td>HP Reorder Number</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td><strong>Paper Media</strong></td>
<td></td>
</tr>
<tr>
<td>HP Bright White Inkjet Paper</td>
<td></td>
</tr>
<tr>
<td>European A4, 500 sheets</td>
<td>C1825A</td>
</tr>
<tr>
<td>European A4, 200 sheets</td>
<td>C5977A</td>
</tr>
<tr>
<td>U.S. letter, 200 sheets</td>
<td>C5976A</td>
</tr>
<tr>
<td>U.S. letter, 500 sheets</td>
<td>C1824A</td>
</tr>
<tr>
<td>HP Premium Inkjet Paper</td>
<td></td>
</tr>
<tr>
<td>European A4, 200 sheets</td>
<td>51634Z</td>
</tr>
<tr>
<td>U.S. letter, 50 sheets</td>
<td>51634Y</td>
</tr>
<tr>
<td>HP Premium Inkjet Heavyweight Paper</td>
<td></td>
</tr>
<tr>
<td>European A4, 100 sheets</td>
<td>C1853A</td>
</tr>
<tr>
<td>U.S. letter, 200 sheets</td>
<td>C1852A</td>
</tr>
<tr>
<td>HP Premium Brochure &amp; Flyer Paper, Matte</td>
<td></td>
</tr>
<tr>
<td>U.S. letter, 50 sheets</td>
<td>C6955A</td>
</tr>
<tr>
<td>HP Professional Brochure &amp; Flyer Paper, Glossy</td>
<td></td>
</tr>
<tr>
<td>Asian A4, (210 x 297 mm)</td>
<td>C6819A</td>
</tr>
<tr>
<td>European A4 (210 x 297 mm), 50 sheets</td>
<td>C6818A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets</td>
<td>C6817A</td>
</tr>
<tr>
<td>HP Photo Paper, Two-Sided, Satin/Glossy</td>
<td></td>
</tr>
<tr>
<td>Asian A4, 20 sheets</td>
<td>C6765A</td>
</tr>
<tr>
<td>European A4, 20 sheets</td>
<td>C1847A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets</td>
<td>C1846A</td>
</tr>
<tr>
<td>HP Premium Photo Paper, Glossy</td>
<td></td>
</tr>
<tr>
<td>Asian A4, 15 sheets</td>
<td>C6043A</td>
</tr>
<tr>
<td>European A4, 15 sheets</td>
<td>C6040A</td>
</tr>
<tr>
<td>U.S. letter, 15 sheets</td>
<td>C6039A</td>
</tr>
</tbody>
</table>

**Availability of special media varies by country.**

<table>
<thead>
<tr>
<th>Parts/Supplies Accessories</th>
<th>HP Reorder Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Paper Media (continued)</strong></td>
<td></td>
</tr>
<tr>
<td>HP Premium Plus Photo Paper, Glossy</td>
<td></td>
</tr>
<tr>
<td>Asian A4, 20 sheets</td>
<td>C6933A</td>
</tr>
<tr>
<td>European A4, 20 sheets</td>
<td>C6832A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets</td>
<td>C6831A</td>
</tr>
<tr>
<td>HP Premium Plus Photo Paper, Matte</td>
<td></td>
</tr>
<tr>
<td>European A4, 20 sheets</td>
<td>C6951A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets</td>
<td>C6950A</td>
</tr>
<tr>
<td>HP Premium Inkjet Transparency Film</td>
<td></td>
</tr>
<tr>
<td>European A4, 20 sheets</td>
<td>C3832A</td>
</tr>
<tr>
<td>European A4, 50 sheets</td>
<td>C3535A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets</td>
<td>C3828A</td>
</tr>
<tr>
<td>U.S. letter, 50 sheets</td>
<td>C3834A</td>
</tr>
<tr>
<td>HP Premium Inkjet Rapid-Dry Transparencies</td>
<td></td>
</tr>
<tr>
<td>European A4, 50 sheets</td>
<td>C6053A</td>
</tr>
<tr>
<td>U.S. letter, 50 sheets</td>
<td>C6051A</td>
</tr>
<tr>
<td>HP Glossy Greeting Card Paper, White/Half-fold</td>
<td></td>
</tr>
<tr>
<td>European A4: 10 sheets, 10 envelopes</td>
<td>C6045A</td>
</tr>
<tr>
<td>U.S. letter: 20 sheets, 20 envelopes</td>
<td>C6044A</td>
</tr>
<tr>
<td>HP Matte Greeting Card Paper, White/Quarter-Fold</td>
<td></td>
</tr>
<tr>
<td>European A4: 20 sheets, 20 envelopes</td>
<td>C6042A</td>
</tr>
<tr>
<td>U.S. letter: 20 sheets, 20 envelopes</td>
<td>C1812A</td>
</tr>
<tr>
<td>HP Felt-textured Greeting Card Paper, Ivory/Half-fold</td>
<td></td>
</tr>
<tr>
<td>U.S. letter: 20 sheets, 20 envelopes</td>
<td>C6828A</td>
</tr>
</tbody>
</table>
Ordering Information

To order printer supplies or accessories, call your nearest HP dealer or call HP DIRECT at the following numbers for fast shipping service.

In the U.S., you can buy supplies and accessories directly from HP at www.hpshopping.com, or call the HP Shopping Village at 1-888-999-4747.

- **Argentina**: (54 1) 787-7100
  Fax: (54 1) 787-7213
  Hewlett-Packard Argentina,
  Montañeses 2150 1428
  Buenos Aires, Argentina

- **Australia/New Zealand**: (03) 895-2895
  China Resources Bldg.
  26 Harbour Road
  Wanchai, Hong Kong

- **Brazil**: Centro de Informacoes HP
  Grande São Paulo: 822-5565
  Demais Localidades: 0800-157751
  Fax: (011) 829-7116
  Centro de Informacoes HP
  Hewlett Packard Brasil S.A.
  Caixa Postal 134, Rua Clodomiro Amazonas, 258
  CEP 04534-011, São Paulo - SP

- **Belgium**: 02/778 3092 (or 3090, 3091)
  Fax: 02/778 3076
  Hewlett-Packard Belgium SA/NV
  100 bd. de la Woluwe/Woluwedal
  1200 BRUXELLES

- **Brazil**: Centro de Informacoes HP
  Grande São Paulo: 822-5565
  Demais Localidades: 0800-157751
  Fax: (011) 829-7116
  Centro de Informacoes HP
  Hewlett Packard Brasil S.A.
  Caixa Postal 134, Rua Clodomiro Amazonas, 258
  CEP 04534-011, São Paulo - SP

- **Canada**: (800) 387-3154, (905) 206-4725
  Fax: (905) 206-3485/-3739
  Hewlett-Packard (Canada) Ltd.
  5150 Spectrum Way
  Mississauga, Ontario L4W 5GI
  Toronto: (416) 671-8383

- **Chile**: (56 2) 203-3233
  Fax: (56 2) 203-3234
  Hewlett-Packard de Chile SA
  Av. Andres Bello 2777, Oficina 1302
  Los Condes, Santiago, Chile

- **Denmark**: 45 99 14 29
  Fax: 42 81 58 10
  Hewlett-Packard A/S
  Kongevejen 25, 3460 BIRKEROD

- **Finland**: (90) 8872 2397
  Fax: (90) 8872 2620
  Hewlett-Packard Oy
  Varaosamynti, Piispakkialliotie 17
  02200 ESPOO

- **France**: (1) 40 85 71 12
  Fax: (1) 47 98 26 08
  EuroParts
  77 101 avenue du Vieux Chemin de Saint-Denis
  92625 GENNEVILLETIERS

- **Germany**: 07031-145444
  Fax: 07031-141395
  Hewlett-Packard GmbH, HP Express Support
  Ersatzteil-Verkauf, Herrenberger Str. 130
  71034 BÖBLINGEN

- **International Sales Branch**: (41) 22 780 4111
  Fax: (41) 22 780-4770
  Hewlett-Packard S. A., ISB
  39, rue de Veyrot 1217 MEYRIN 1
  GENEVE - SUISSE

- **Italy**: 02/9212.2336/2475
  Fax: 02/9210.757
  Hewlett-Packard Italiana S. P. A.
  Ufficio Parti di ricambio
  Via G. Di Vittorio, 9
  20063 Cernusco s/N (MI)

- **Japan**: (03) 3335-8333
  Hewlett-Packard Japan Ltd.
  29-21 Takaido-Higashi 3-chone, suginami-ku
  Tokyo 168-8585
Language Codes
for DOS

The language codes for locating the dosread.txt file on the printer software CD are listed below. This text file is in the \language code\djcp\ directory on the printer software CD.

<table>
<thead>
<tr>
<th>Language</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chinese, Simplified</td>
<td>chs</td>
</tr>
<tr>
<td>Chinese, Traditional</td>
<td>cht</td>
</tr>
<tr>
<td>Czech</td>
<td>csy</td>
</tr>
<tr>
<td>Danish</td>
<td>dan</td>
</tr>
<tr>
<td>German</td>
<td>deu</td>
</tr>
<tr>
<td>English</td>
<td>enu</td>
</tr>
<tr>
<td>Spanish</td>
<td>esm</td>
</tr>
<tr>
<td>Finnish</td>
<td>fin</td>
</tr>
<tr>
<td>French</td>
<td>fra</td>
</tr>
<tr>
<td>Hungarian</td>
<td>hun</td>
</tr>
<tr>
<td>Italian</td>
<td>ita</td>
</tr>
<tr>
<td>Korean</td>
<td>kor</td>
</tr>
<tr>
<td>Dutch</td>
<td>nld</td>
</tr>
<tr>
<td>Norwegian</td>
<td>non</td>
</tr>
<tr>
<td>Polish</td>
<td>plk</td>
</tr>
<tr>
<td>Portuguese</td>
<td>ptb</td>
</tr>
<tr>
<td>Russian</td>
<td>rus</td>
</tr>
<tr>
<td>Swedish</td>
<td>svc</td>
</tr>
<tr>
<td>Thai</td>
<td>tha</td>
</tr>
</tbody>
</table>
Environmental Attributes of the DeskJet Printer

Environmental Statement
Hewlett-Packard continuously improves the design and production processes of HP DeskJet printers to minimize the negative impact on the office environment and on the communities where printers are manufactured, shipped, and used. Hewlett-Packard has also developed processes to minimize the negative impact of the disposal of the printer at the end of printing life.

Reduction and Elimination
Ozone: All ozone-depleting chemicals (CFC, for example) have been eliminated from Hewlett-Packard manufacturing processes.
Number of Parts: Early in design, the total number of parts used by the printer is reduced when possible to minimize costs during manufacturing and to reduce handling at end-of-life.
Printer Packaging: The packaging materials for this printer have been selected to provide maximum protection for the least cost possible, while attempting to minimize environmental impact and facilitate recycling. The rugged design of the HP DeskJet printer assists in minimizing both packaging materials and damage rates.

Recycling
Design for recycling has been incorporated into this printer. The number of materials has been kept to a minimum, and dissimilar materials have been designed to separate easily. Fasteners and connectors are easy to locate, access, and remove using common tools. High priority parts have been designed to be accessed quickly for efficient disassembly and repair.

Plastics parts have been primarily designed in no more than two colors to enhance recycling options.

Plastic Materials: All major manufactured plastics parts are marked as to the plastic content to facilitate product recycling.

Printers and Print Cartridges: In certain countries, Hewlett-Packard is conducting pilot programs to take back printers and print cartridges for material reclamation and environmentally sound disposal. Call your Hewlett-Packard representative for current status.

Paper: This printer is designed to facilitate the use of recycled paper as consumer media. Depending on the availability of recycled paper in each country, all manuals are printed on recycled paper.

Energy Conservation
This printer was designed with energy conservation in mind. This printer uses less than 5 watts in stand-by mode. As an ENERGY STAR partner, Hewlett-Packard has determined that this product meets the ENERGY STAR guidelines for energy efficiency.

Off-mode Energy Consumption: When the printer is in off-mode, a minimal amount of energy is still being consumed. Turning off the printer and then disconnecting the printer power cord from the electrical source can prevent energy consumption.